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Question 1: Image Extraction at Best Quality 
 
 
Qn.1A, if you used another method: 
Please save and submit your results using the filename: 
'Q1A_OtherMethod_YOURINITIALS'  
 
Please specify (i) the investigation method used to a) examine the video sequence and 
b) extract and examine the frame, (ii) all tools used, and (iii) all steps executed. The 
information you provide should have sufficient detail so that anyone could independently 
reproduce your results. 
 
First of all, I checked the integrity of the file using the provided PGP signature. To do so, 
I used Gpg4Win software (with Kleopatra GUI) in the following way: 

- I clicked on “Import certificates” and imported the publick key from 8903E64F.gpg 
- I right clicked the certificate and “Certified it” by signing it with my own certificate  
- I chose File -> Decrypt/Verify, selected the [000001].sig file, checked the “Input 

file is a detatched signature” box and browsed to [000001].dvr file. The software 
gives the following output: 

 

  
This is enough to certify the integrity of the file. 
 
I used AMPED FIVE (Rev. 6762) DVR conversion system (File -> Convert DVR) to 
convert the .drv file to a supported format, choosing: 
- “Copy stream if possible” 
- “Raw” as video codec so to avoid re-compression.  
 
AMPED Five’s engine used ffmpeg library to convert the video to a supported format. 
Ffmpeg detected a H.264 video stream, as explained in the log file: 
 

 
 
This means that ffmpeg was able to just extract the video stream from the proprietary 
container, without any decoding/re-encoding step. Then, I imported the obtained file in 
AMPED Five and used the “Image writer” filter to save the first frame of the video to a 
bitmap (i.e., uncompressed) file. 
 
 
 
 
 
 
 

Stream #0:0, 127, 1/1200000: Video: h264 (Baseline), yuv420p, 720x288, 25 fps, 25 tbr, 1200k 
tbn, 50 tbc 
 

Signed on 2014-05-08 20:45 by 00D08903E64F ((DG08X Ver 1.0)) (Key ID: 0x07563BE8). 
The signature is valid and the certificate's validity is fully trusted 

key:EE9CF3D3518ECB5416EBC484563CC70607563BE8
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Qn.1B, if you used another method: 
Please save and submit your results using the filename 
'Q1B_OtherMethod_YOURINITIALS'  
 
Please specify (i) the investigation method used to a) examine the video sequence and 
b) extract and examine the frame, (ii) all tools used, and (iii) all steps executed. The 
information you provide should have sufficient detail so that anyone could independently 
reproduce your results. 
 
I used AMPED FIVE DVR conversion system (File -> Convert DVR) to convert the .drv 
file to a supported format, choosing: 
- “Copy stream if possible” 
- “Raw” as video codec so to avoid re-compression.  
 
AMPED FIVE’s engine used ffmpeg library to convert the video to a supported format. 
Ffmpeg detected a M-JPEG video stream, as explained in the log file: 
 

 
 
This means that ffmpeg was able to just extract the from the proprietary container, 
without any decoding/re-encoding step. Then, I imported the obtained file in AMPED 
FIVE. Since the imported video has no timestamps, I installed the provided Player and 
checked the framerate of the recorder: by advancing frame-by-frame checking the 
timestamps, I reached the conclusion that the video was recorded at 6 fps. Since the 
initial timestamp is exactly 40s before the desired frame, I took the frame number 240 in 
AMPED Five imported video and used “Image writer” filter to save it to a bitmap, 
uncompressed file. 
 
Qn.1C 
 
 

Frame Size of source file recording 
used in Qn.1A 

Frame Size of source file recording 
used in Qn.1B 

720 x 288 pixels 720 x 288 pixels 

 
What are your conclusions about the raw, encoded quality of the provided video 
frame/sequence in Q1A and Q1B? 
 
 
As to the file in Qn.1A, the video stream is compressed using H.264, with baseline 
profile, the GOP structure is static (IPPPPP). Frames show a good contrast and no 
relevant blocking artifacts. 
 
As to the file in Qn.1B, MJPEG coding is detected (only I-frames). Pixels show annoying 
blocking artifacts, and levels are poorly distributed, resulting in low contrast. 
 

Stream #0:0, 0, 1/50: Video: mjpeg (MJPG / 0x47504A4D), yuvj420p, 720x288 [SAR 50:25 DAR 
5:1], q=2-31, 25 fps, 50 tbn, 50 tbc 
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Both videos show a spatial resolution of 720x288, which suggests the video height is 
half the standard PAL (576). This can be due to: i) different fields of an interlaced video 
being stored in two consecutive frames; ii) a memory-saving policy which does not store 
interpolated fields in each frame.  
We believe the second applies to our case, so the aspect ratio can be corrected using 
AMPED FIVE “Edit -> Correct aspect ratio” filter, which adds interpolated lines (e.g., 
calculated with cubic interpolation). After application of this filter, the video is at standard 
PAL resolution: 720x576 pixels. 
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Question 2: Super-Resolution from supplied sequence of 249 .bmp files 
 
Qn.2A 
 
Please select your best result, i.e.: a single best quality super-resolution image:  
Please save and submit your results using filename: “Q2A_SuperRes_YOURINITIALS” 
 
1. How have you ingested the material into your enhancement system and super-

resolution software tools?   
Please detail all steps of any conversion performed including all software tools and 
settings used. The information you provide should have sufficient detail so that 
anyone could independently reproduce your results.  
 
I have used AMPED FIVE “Sequence Loader” filter, that is automatically enabled by 
dragging files into AMPED FIVE. 

 
 
 

Please specify all software tools and all Enhancement Filters used (in order) and 
specific parameter settings; e.g. Super-Resolution Filter (Method? Zoom factor? 
Number of Iterations?  Interpolation?......)  
 
The following filters in AMPED FIVE were used:  
 
1. Sequence Loader 

Parameters:  

 Files: [all files in the uncompressed archive] 

 Fps: 25 

2. Super Resolution 

Parameters:  

 Zoom: 2 (Zoom factor for the output image.) 

 Iterations: 15 (Number of deblurring steps.) 

 Selection: 6 13 29 9 (Region of the image to optimize.) 

References:  

 Hiroyuki Takeda, Peyman Milanfar, Matan Protter, and Michael Elad. 2009. Super-

resolution without explicit subpixel motion estimation. Trans. Img. Proc. 18, 9 

(September 2009), 1958-1975. DOI=10.1109/TIP.2009.2023703 

http://dx.doi.org/10.1109/TIP.2009.2023703 
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3. Optical Deblurring 

Parameters:  

 Size: 2 (The size of the point spread function.) 

 Noise: 0.0151 (Estimate of the noise-to-signal power ratio.) 

 Boundary conditions: Symmetric (Reduce ringing artifacts near the boundaries of the 

image) 

References:  

 J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice 

Hall, NY, p. 548, equations 9.44 -- 9.46, 1990. 

 Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 

1989. 

4. Unsharp Masking 

Parameters:  

 Strength: 0.2700 (Intensity of the sharpening effect: larger values provide increasing 

amounts of sharpening.) 

 Size: 57 (Size of the filter.) 

 Threshold: 0 (The minimum difference in pixel values that indicates an edge where 

sharpen must be applied.) 

 Mode: Intensity (Type of adjustment to be done.) 

 Selection: Whole Image 

References:  

 Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 249-250, 

1989. 

5. Resize 

Parameters:  

 Size: 356, 292 (Size of output image.) 

 Interpolation: Bicubic (Interpolation algorithm) 

References:  

 Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 253-255, 

1989. 
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 Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 320-322, 

1989. 

 H.S. Hou and H.C. Andrews, Cubic spline for image interpolation and digital filtering, 

in IEEE Transactions on Acoustic, Speech, and Signal Processing, vol. 26, pp. 508-

517, 1978. 

6. Hue Saturation Value 

 

Parameters:  

 Hue: 0 (Adds or subtracts a constant to the hue of the image. It adjusts the offset of a 

linear mapping.) 

 Saturation: -78 (Multiplies by a constant to the saturation of the image. It adjusts the 

slope of a linear mapping.) 

 Value: 0 (Multiplies by a constant to the value of the image. It adjusts the slope of a 

linear mapping.) 

 Selection: Whole Image 

 

References:  

 Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 60-71, 

1989. 

 Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 

1989. 

 

7. Image Writer 

Parameters:  

 File: E:/S-FIVE/2A/Q2A_SuperRes_ID12.bmp 

 Format: Bitmap 

 
 
3. Did you select a ”region of interest” for directing the super-resolution tool? If so 

please specify co-ordinates of the region (if used) in the format given by the tool.  
 
Yes, the region was  6 13 29 9.  
 

4. Did you select any specific frames or image? If so, please provide details of range of 
frames or specific frames you used.  
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5. Please provide any other information that would be needed so that others would be 
able to repeat and reproduce your work.  
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Qn.2B 
 
 
Please select your best result, i.e.: a single best quality super-resolution image:   
Please save and submit your results using filename: “Q2B_SuperRes_YOURINITIALS” 
 
 
1. How have you ingested the material into your enhancement system and super-

resolution software tools?   
Please detail all steps of any conversion performed including all software tools and 
settings used. The information you provide should have sufficient detail so that 
anyone could independently reproduce your results.  
 
I used AMPED FIVE DVR conversion tool (File -> Convert DVR) to convert the video 
to a compatible format. I checked the “copy stream if possible” option, and according 
to the log file AMPED FIVE was able to just extract the H.264 video stream from the 
proprietary container, without re-compressing it. Frames were just written to a RAW 
video file (AVI container), that can be imported in AMPED FIVE.  

 
 
 
2. Which of the 5 number plates have you concentrated your efforts on (1=closest 

number plate, ...,  5=most distant) and how did you decide on selecting this number 
plate?  
 
Selected no. plate: 1   
  
Decision reached how:  
Being closer and near to the center of the image, the number plate 1 is more likely 
readable. Moreover, we can’t exclude that tuning the filters for that plate will also 
improve readability of other plates.  
 
 
 

3. Please specify all software tools and all enhancement filters used (in order) and 
specific parameter settings; e.g. Super-Resolution Filter (Method? Zoom factor? 
Number of Iterations?  Interpolation?......)  
 
I used AMPED FIVE, with the following chain of filters: 
Video Loader 
Parameters: 
File: TestP_7mDistance_MidElevation.dav-converted.avi 
Path of the video to load. 
Video Engine: FFMS 
Video decoder to use. 
Original File: F:\S-FIVE\2B\TestP_7mDistance_MidElevation.dav 
Original video file that has been converted from a proprietary DVR format. 
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Crop 
Parameters: 
Selection: Static Region 
Reference Selection(s) 
0: 167 90 45 96 
 
Range Selector (Selects frames of the video within an interval with an optional 
step). 
Parameters: 
First Frame: 81 
Last Frame: 175 
Step: 1 
 
Rotate 
Parameters: 
Angle: 180 
Resize Image to Fit: true 
Interpolation: Bicubic 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 253-255, 
1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 320-322, 
1989. 
H.S. Hou and H.C. Andrews, Cubic spline for image interpolation and digital filtering, 
in IEEE Transactions on Acoustic, Speech, and Signal 
Processing, vol. 26, pp. 508-517, 1978. 
 
Super Resolution 
Parameters: 
Zoom: 3 
Iterations: 10 (Number of deblurring steps). 
Selection: 2 2 41 17 (Region of the image to optimize). 
References: 
Hiroyuki Takeda, Peyman Milanfar, Matan Protter, and Michael Elad. 2009. Super-
resolution without explicit subpixel motion estimation. Trans. 
Img. Proc. 18, 9 (September 2009), 1958-1975. DOI=10.1109/TIP.2009.2023703 
http://dx.doi.org/10.1109/TIP.2009.2023703 
 
Optical Deblurring 
Parameters: 
Size: 4 (The size of the point spread function.) 
Noise: 0.1805 (Estimate of the noise-to-signal power ratio.) 
Boundary conditions: Symmetric 
References: 
J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice 
Hall, NY, p. 548, equations 9.44 -- 9.46, 1990. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 
1989. 
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Resize 
Parameters: 
Size: 375, 834 
Interpolation: Bicubic 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 253-255, 
1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 320-322, 
1989. 
H.S. Hou and H.C. Andrews, Cubic spline for image interpolation and digital filtering, 
in IEEE Transactions on Acoustic, Speech, and Signal 
Processing, vol. 26, pp. 508-517, 1978. 
 
Unsharp Masking 
Parameters: 
Strength: 0.5300 (Intensity of the sharpening effect: larger values provide increasing 
amounts of sharpening.) 
Size: 115 (Size of the filter.)  
Threshold: 0 
Mode: Intensity 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 249-250, 
1989. 

 
4. Did you select a “region of interest” for directing the super-resolution tool? If so 

please specify co-ordinates of the region (if used) in the format given by the tool.  
 
I selected a square region containing the desired plate. However, coordinate 
specified in the tool are not those of the original frames, since I cropped the video 
and rotated it by 180 degrees. Coordinates in the cropped and rotated plane are 2 2 
41 17 (x y w h). See the filter list at point 3 for details about cropping and rotation, 
allowing mapping the above coordinates to those of the original image. 
 
 

5. Did you select any specific frames or image? If so, please provide details of range of 
frames or specific frames you used.  
 
I selected frames in the range [81 175] because lower camera motion is observed in 
that window.  
 
 

6. Please provide any other information that would be needed so that others would be 
able to repeat and reproduce your work.   
 
Use any space you need  
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Question 3: Focal deblur test 
 
Please specify (i) all software tools or processing steps, (ii) all enhancement filters used 
(in order) and (iii) all specific parameter settings. The information you provide should 
have sufficient detail so that anyone could independently reproduce your results.  
 
I used AMPED FIVE, details about each enhancement follow: 
 
125 cm chart:  
Please save and submit your results using filename: 'Q3_125cm_YOURINITIALS' or 
'Q3_125cm_LineNUMBER_YOURINITIALS' 
 
Image Loader 
Parameters: 
File: Random_Focus_150cm_from_lens.JPG 
The path of the file to load. 
 
Crop 
Parameters: 
Selection: Static Region 
Reference Selection(s) 
0: 1006 222 825 1294 
 
Optical Deblurring 
Parameters: 
Size: 43 The size of the point spread function. 
Noise: 0.0068 Estimate of the noise-to-signal power ratio. 
Boundary conditions: Edge Tapering  
References: 
J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice Hall, NY, 
p. 548, equations 9.44 -- 9.46, 1990. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 1989. 
 
Unsharp Masking 
Parameters: 
Strength: 1 
Size: 85 
Threshold: 0 
Mode: Intensity 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 249-250, 1989. 
 
Hue Saturation Value 
Parameters: 
Hue: 0 
Saturation: -23 
Value: 0 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 60-71, 1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 



 

S-FIVE CE Answer Form ID 12: Page 12 of 18 

 

 
Contrast Brightness 
Parameters: 
Contrast: 31 
Brightness: -14 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 
 
75 cm, 4th line: 
Please save and submit your results using filename: 'Q3_75cm_Line4_YOURINITIALS' 
 
Image Loader 
Parameters: 
File: F:/S-FIVE/3/Random_Focus_150cm_from_lens.JPG 
 
Crop 
Parameters: 
Selection: Static Region 
0: 233 950 909 360 
 
Motion Deblurring 
Parameters: 
Size: 7 
Angle: 77 
Noise: 0.0090 
Boundary conditions: Symmetric 
Mode: Replica 
Thickness: 15 
References: 
J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice Hall, NY, 
p. 548, equations 9.44 -- 9.46, 1990. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 1989. 
 
Unsharp Masking 
Parameters: 
Strength: 0.5000 
Size: 99 
Threshold: 0 
Mode: Intensity 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 249-250, 1989. 
 
Levels 
Parameters: 
Value: 217, 155, 93 
Red: 255, 127, 0 
 
Green: 255, 127, 0 
Blue: 255, 127, 0 
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Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 
Hue Saturation Value 
Parameters: 
Hue: 0 
Saturation: -13 
Value: 0 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 60-71, 1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 
 
75 cm, 5th line: 
Please save and submit your results using filename: Q3_75cm_Line5_YOURINITIALS' 
 
Image Loader 
Parameters: 
File: Random_Focus_150cm_from_lens.JPG 
 
Crop 
Parameters: 
Selection: Static Region 
0: 446 1190 546 88 
 
Optical Deblurring 
Parameters: 
Size: 18 
Noise: 0.0126 
Boundary conditions: Symmetric 
 
References: 
J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice Hall, NY, 
p. 548, equations 9.44 -- 9.46, 1990. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 1989. 
 
Unsharp Masking 
Parameters: 
Strength: 1 
Size: 57 
Threshold: 0 
Mode: Intensity 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 249-250, 1989. 
 
Hue Saturation Value 
Parameters: 
Hue: 0 
Saturation: -40 
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Value: 0 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 60-71, 1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 
Levels 
Parameters: 
Value: 233, 154, 75 
Red: 255, 127, 0 
Green: 255, 127, 0 
Blue: 255, 127, 0 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 
Resize 
Parameters: 
Size: 1092, 176 
Interpolation: Bicubic 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 253-255, 1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 320-322, 1989. 
H.S. Hou and H.C. Andrews, Cubic spline for image interpolation and digital filtering, in IEEE 
Transactions on Acoustic, Speech, and Signal 
Processing, vol. 26, pp. 508-517, 1978. 
 
any other results: optional: 
Please save and submit your results using filenames: 
'Q3_DISTANCEcm_LineNUMBER_YOURINITIALS' 
 
Use any space you need  
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Question 4: Motion deblur test 
 
Qn.4A:  
 
Please specify (i) all software tools or processing steps, (ii) all enhancement filters used 
(in order) and (iii) all specific parameter settings. The information you provide should 
have sufficient detail so that anyone could independently reproduce your results.  
If you wish to provide results for different regions of interest in the image, please specify 
their coordinates and/or indicate the region in a small thumbnail, and use the filenames: 
“Q4A_RegionNUMBER_YOURINITIALS”. 
 
Region NUMBER: coordinates and/or thumbnail: 
 
 
I used AMPED FIVE.  
 
Region 0: 117 453 2453 505 (x y w h) 
 
Crop 
Crops a region of interest of the image. 
Details: 
The Crop tool produces an output image which is only the selected region of the input image. 
Parameters: 
Selection: Static Region 
Reference Selection(s) 
0: 117 453 2453 505 
Selection where the filter is applied. It may be the whole image, a static region, or a region 
containing a tracked object of interest. 
 
Motion Deblurring 
Parameters: 
Size: 28 
Angle: 5 
Noise: 0.0079 
Boundary conditions: Symmetric 
Mode: Linear 
Thickness: 3 
References: 
J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice Hall, NY, 
p. 548, equations 9.44 -- 9.46, 1990. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 1989. 
 
Hue Saturation Value 
Parameters: 
Hue: 0 
Saturation: -12 
Value: 0 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 60-71, 1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
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Region 1: 385 1467 502 107 (x y w h) 

 
Crop 
Parameters: 
Selection: Static Region 
0: 385 1467 502 107 
 
Motion Deblurring 
Parameters: 
Size: 32 
Angle: 5 
Noise: 0.0100 
Boundary conditions: Symmetric 
Mode: Linear 
Thickness: 2 
References: 
J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice Hall, NY, 
p. 548, equations 9.44 -- 9.46, 1990. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 1989. 
 
Levels 
Parameters: 
Value: 199, 99, 0 
Red: 255, 127, 0 
Green: 255, 127, 0 
Blue: 255, 127, 0 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 
Region 2: 1653 1427 309 121 (x y w h) 
 
Crop 
Parameters: 
Selection: Static Region 
0: 1653 1427 309 121 
 
Motion Deblurring 
Parameters: 
Size: 31 
Angle: 0 
Noise: 0.0201 
Boundary conditions: Symmetric 
Mode: Linear 
Thickness: 2 
References: 
J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice Hall, NY, 
p. 548, equations 9.44 -- 9.46, 1990. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 1989. 
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Unsharp Masking 
Parameters: 
Strength: 0.6300 
Size: 59 
Threshold: 0 
Mode: Intensity 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 249-250, 1989. 
 
Levels 
Parameters: 
Value: 211, 105, 0 
Red: 255, 127, 0 
Green: 255, 127, 0 
Blue: 255, 127, 0 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 
Hue Saturation Value 
Parameters: 
Hue: 0 
Saturation: -9 
Value: 0 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 60-71, 1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 
Resize 
Parameters: 
Size: 618, 242 
Interpolation: Bicubic 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 253-255, 1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 320-322, 1989. 
H.S. Hou and H.C. Andrews, Cubic spline for image interpolation and digital filtering, in IEEE 
Transactions on Acoustic, Speech, and Signal 
Processing, vol. 26, pp. 508-517, 1978. 
 
 
 
Qn.4B:  
 
Please specify (i) all software tools or processing steps, (ii) all enhancement filters used 
(in order) and (iii) all specific parameter settings. The information you provide should 
have sufficient detail so that anyone could independently reproduce your results.  
If you wish to provide results for different regions of interest in the image, please specify 
their coordinates and/or indicate the region in a small thumbnail, and use the filenames: 
“Q4A_RegionNUMBER_YOURINITIALS”. 
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I used AMPED FIVE. 
 
Crop 
Parameters: 
Selection: Static Region 
0: 470 1614 852 322 
 
Nonlinear Deblurring 
Parameters: 
Points: 
454, 48 
459, 49 
462, 50 
464, 52 
466, 56 
466, 62 
466, 70 
467, 76 
469, 82 
472, 88 
478, 91 
487, 90 
Noise: 0.0100 
References: 
J.S. Lim, Two-Dimensional Signal and Image Processing, Englewood Cliffs, Prentice Hall, NY, 
p. 548, equations 9.44 -- 9.46, 1990. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 276-284, 1989. 
 
Hue Saturation Value 
Parameters: 
Hue: 0 
Saturation: -17 
Value: -7 
Selection: Whole Image 
References: 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 60-71, 1989. 
Anil. K. Jain, Fundamentals of Digital Image Processing, Prentice Hall, pp. 234-241, 1989. 
 

 
 
 
 
 
 


